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New Era, New 
Opportunities: 

Making Medicaid 
Work for You



August 19: Medicaid Dental: New Rates, Better Coverage

August 26: Your Practice, Your Way: Managing Your Patient Mix

September 2: Get to Know Your MCOs

September 9: Enrollment & Credentialing

September 16: Filing Medicaid Claims

September 23: Do Well by Doing Good: Medicaid Opportunities

September 30: My Dental Care Passport

New Era, New Opportunities Webinar Series



Logistics

• Please use the Q&A box to ask 
questions throughout today’s webinar

• If you have any questions or run into 
any technical problems, please use 
the Chat, and the staff will help you

• You also can email 
info@oralhealthkansas.org if you have 
any problems during the webinar

• There will be a total of 3.5 dental CEs 
available for participating in this 
webinar series 

• If you need CEs, please put your name 
and email address in the Chat

• CE certificates will be sent at the end 
of the webinar series

mailto:info@oralhealthkansas.org
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Join us in making dental care more accessible and equitable for all.

• Support for dental professionals in being 
successful Medicaid providers

• Education programs for dental 
professionals and people with disabilities 

• Communication tools to break down 
barriers
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This project is funded by the Kansas Department of Health and Environment – 
Division of Health Care Finance (KDHE-DHCF) and ARPA.

New Era, New Opportunities Webinar Series



• SkyGen (On behalf of Healthy Blue)
• Centene (Representing Sunflower)
• United Healthcare Community Plan
• Resources

Today’s agenda
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https://www.healthybluekansas.com/provider/state-federal 

https://www.sunflowerhealthplan.com/providers.html 

https://www.uhcdental.com/ 

https://www.healthybluekansas.com/provider/state-federal
https://www.healthybluekansas.com/provider/state-federal
https://www.healthybluekansas.com/provider/state-federal
https://www.sunflowerhealthplan.com/providers.html
https://www.uhcdental.com/


Healthy Blue Kansas
Oral Health Kansas Webinar

09/16/2025



member identification card

For your reference, we have 
included a copy of a member 
identification card, so when 
presented you will be familiar 
with it: 
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Medicaid

Medicare

Dual (D-SNP)



SKYGEN - Dental Hub
SKYGEN Dental Hub: https://app.dentalhub.com/app/login

• Is a secure online service that offers quick, easy-to-use self- service tools for providers and their office staff. The 
portal is available 24 hours a day, 7 days a week from any computer with internet access. Utilizing the portal 
speeds up processing time, helps lower administrative time and costs, and allows providers to perform a wide 
variety of daily administrative tasks such as but not limited to:

• Checking member eligibility, benefits, and history 

• Submitting authorizations and claims

• Searching authorizations and claims

• Viewing insurer documents, provider notices, and remittances

• For help utilizing the SKYGEN Dental Hub, registering, or training visit: https://www.dentalhub.com/webinars

• For support with the SKYGEN Dental Hub Team: Phone #: 1-855-609-5156.
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https://app.dentalhub.com/app/login
https://www.dentalhub.com/webinars


checking Eligibility
Providers can verify Member eligibility several ways:

• Visit SKYGEN Dental Hub at: https://app.dentalhub.com/app/login

• Provider Services Contact Center for assistance at 855-434-9237

Dental Hub:

A Quick Eligibility Search indicates whether the patient is eligible on the given date of service.

Log onto the Dental Hub then:

1. Subscriber ID

2. Date of birth

3. Select Healthy Blue payer

4. Date of service

5. Click search
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https://app.dentalhub.com/app/login


checking Eligibility
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Full Eligibility & History Search gives you access to benefit information and service history plus quick links to the 
treatment plan calculator, start a claim, and submit authorization with that patient's information prefilled. 



checking Eligibility
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Eligibility status is displayed with three distinct indicators: 



Key Addresses 
Payer ID:

• SCION

Authorizations/Retro Authorizations:

• Healthy Blue Kansas Authorizations PO BOX 1236 Milwaukee, WI 53201

Claims:

• Healthy Blue Kansas Claims PO BOX 359 Milwaukee, WI 53201

Corrected Claims:

• Healthy Blue Kansas Corrected Claims PO BOX 541 1236 Milwaukee, WI 53201

Auth Appeals:

• Healthy Blue Kansas Authorizations Appeals PO BOX 62429 Virginia Beach, VA 23466

Claim Appeals:

• Healthy Blue Claim Appeals PO BOX 61599 Virginia Beach, VA 23466
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Plus - Submitting a Corrected Claim

1.   Navigate to the appropriate page:
• Status & History page (for Dental Hub 

claims)
• Claim Search page (for non-Dental Hub 

claims)

2.   Locate your claim and select "Correct Claim"     
from the Options menu
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Submitting a Corrected Claim via the Dental Hub
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Status & History

After Correction: All corrected claims appear on the 
Status & History page after submission.



submitting a corrected claim - 
clearinghouse

Corrected claims via Clearinghouse file must include:

• Claim frequency code of 7 (Replacement) or 8 (Void/Cancel) in CLM05-3 element along with 
claim or encounter identifier in REF*F8 element.

• Original claim in a paid status.

• Original claim does not have previously resubmitted services or a corrected claim already 
processed.

• Original claim does not have associated service adjustments or refunds.

• Corrected claim must have a data match to original claim on at least three of the four items: 
Enrollee ID, Provider ID, Location ID, and/or Tax ID.
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submitting a corrected claim - mail

Submitting A Corrected Claim via Paper

• Identify the claim as Corrected by writing “Corrected” across the top of a paper claim form. 

• In the remarks field (Box 35) of the ADA Claim form you must indicated the original paid encounter number 
and record all corrections you are requesting to be made. 

• NOTE: if all information does not fit in Box 35, please attach an outline of the corrections to the claim form. 

• Attach supporting documentation and send documentation in the same package with the paper claim form.

• Send paper forms and documents to: 

Healthy Blue Kansas Corrected Claims 
PO Box 541 
Milwaukee, WI 53201 
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Claims Timely Filing: 180 days from date of service

Claims Timely Filing With Primary insurance: 180 days from primary processed date of EOB

Corrected Claim Timely Filing: 365 days from date of service

Claim Appeals Timely Filing: 60 days of denial date (plus 3 days for mailing time)

Timely filing
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Payments options
I. Zelis Electronic Options (Please note fees may apply*)

Zelis ACH - ACH is the most efficient way to maximize payments for your practice, facility, or health system by directly depositing electronic payments into your bank account. ACH payment delivery is CAQH CORE®- certified, 
which ensures compliance with ACA standards and HIPAA requirements. Once enrolled, your funds are automatically deposited into your bank account. ACH only allows funds to be directly deposited into your account; it 
does not allow funds to be recouped from your account.

Zelis Virtual Card - Zelis has partnered with MasterCard (through Optum Financial) to provide card-based payments. By utilizing the Zelis Virtual Card, office staff simply enters the virtual card information into the card 
terminal to receive payments for the claim(s) submitted. Card numbers and Explanations of Payment can either be download from the Zelis Payments secure web portal or delivered by fax.

• *Fees may apply for all providers who receive payments from Zelis. The fee depends on a variety of factors. For additional information, questions or to enroll, please follow the steps below.

Zelis Enrollment:

• Providers who are already enrolled with Zelis do not need to make any changes and will automatically be paid through Zelis.

• To enroll, please contact the Zelis Provider Enrollment Department at (855) 496-1571 for complete details.

To change your enrollment status:

• To change your enrollment status (including disenrollment from Zelis); please contact the Zelis Client Service Department at (877) 828-8770.

II. SKYGEN E-Payment Center Option (no-fee)

• For Providers seeking an alternative payment solution, SKYGEN is excited to introduce a new electronic payment (E-Payment) platform to accelerate and add efficiency to our claims payment process.

• By enrolling, providers have the ability to receive a no-fee Automated Clearing House (ACH) delivery of claim payments with access to remittance files via download. Delivery of 835 files to clearinghouses is available 
directly through the E-Payment Center enrollment portal.

• Enrollment instructions and a detailed question and answer guide are available for download at https://skygen.epayment.center/Registration.

• Follow the instructions to obtain a registration code. A customer service representative will review your registration and a link will be sent to your email once confirmed.

• For more information, please call (855) 774-4392 or email help@epayment.center.

III. Paper Check Option (no-fee)

Paper Checks - Providers who chose not to enroll with Zelis – or – prefer to receive paper checks can still access their Remittance Reports online.

• Providers will need to send an email message to SKYGEN Customer Services to request electronic remittances: providerservices@skygenusa.com.

• Remittance Reports will be available online through the Dental Hub.
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key contacts   
• Dental Hub: https://app.dentalhub.com/app/login

• Dental Hub Support: 855-609-5156

• Provider Manual & Fee Schedule are posted on the Dental Hub

• Provider Call Center: 855-434-9237

• Call for general questions, benefits, claim & authorization status questions

• Contracting: 800-508-6965, www.skygenusaproviders.com, enter code: (KS)

• Call for adding a new location or new provider, TIN change, address change

• Credentialing: 855-812-9211, providercap.skygenusasystems.com/cap

• Call for credentialing and re-credentialing questions

• Zelis: Enrollment: 855-496-1571 Client Service: 877-828-8770

• ePayment Center: 855-774-4392 or Email: help@epayment.center

• Provider Relations: Email: providerservices@skygenusa.com 
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https://app.dentalhub.com/app/login
http://www.skygenusaproviders.com/
https://providercap.skygenusasystems.com/CAP
mailto:help@epayment.center
mailto:providerservices@skygenusa.com


Thank You

CONNECT WITH US

SKYGENUSA.com

Visit our online Knowledge Center to access helpful 
tips and industry best practices to succeed in the 
future of benefit management.

JOIN THE CONVERSATION
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Changing your “Content 
Slide”.
1. Go to the “Home” tab
2. Select the “Layout” tab
3. Select a slide from the 

“Content Slides” section

Sunflower Health Plan
Eric Rholes, Provider Relations Specialist II
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John Dane, DDS
Sunflower Health Plan

Dr. John Dane serves as Sunflower Health Plan’s Dental Manager.

In the role, Dr. Dane oversees all Sunflower Health Plan oral health activities and 
contractual requirements and serves as a liaison to the State.  

He retired from his position as Missouri State Dental Director in 2021.

He is currently a member of the American Society for Geriatric Dentistry and the 
Academy of Dentistry for the Persons with Disabilities.
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Centene Dental Services, a division of Centene 
Corporation, partners with managed care organizations, 
health plans, and state governments to design and 
administer dental care programs that meet the needs of 
their members. 

We are experienced in handling Medicaid, Health Insurance 
Marketplace, and Medicare benefits. As an organization 
supporting 4 million members in 27 states, we offer your 
practice an opportunity to bring new patients into your 
office. 

Join our panel of over 78,000 dental professionals across 
the country.

Centene Dental Services
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State Plan Information and ID Cards

• Sunflower Health Plan/KanCare
(Medicaid Plan)

− Children Title 19 Age: 0-20
− Children Title 21 CHIP Age: 0-18
− Adults Title 19 Age: 21+
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Provider Web Portal
• centenedental.com/logon

• To register, request assistance through the Provider Resources page online: 
Request Portal Access

− Register as a Provider – See the provider’s claims and authorizations for only one provider 
− Register as a Location – See the location’s claims and authorizations for only one location 
− Register as a Payee – Access to ALL providers and locations associated with payee (tax ID #) 

• Access on the Provider Web Portal (PWP)
− Submit claims 
− Submit authorizations 
− Check member eligibility
− Review EOBs (if registered as a payee) 

https://pwp.envolvedental.com/PWP/Landing
https://pwp.envolvedental.com/PWP/Landing
https://www.centenedental.com/providers/provider-resources.html
https://www.centenedental.com/providers/provider-portal.html


Confidential and Proprietary Information 28

Changing your “Content 
Slide”.
1. Go to the “Home” tab
2. Select the “Layout” tab
3. Select a slide from the 

“Content Slides” section

#00598C #262768 #F58220 #CC401D #CB187D #7F004C #5C2F92 #00A0A4 #034143 #AAC932 #2C8641 #FDB733 #58595B #808285 #DCDDDE#00AEFF #5AC6CE

Brand Colors

28

Enter the following to access 
the most current information:
• Active year

• Line of business

• State

• Product or plan name

Review the hyperlinks for 
more information:
• Code link will provide information 

on frequency limits

• Policy name will provide a 
description of our clinical policies 

Provider Web Portal
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• Authorizations can be submitted three ways:
− Provider Web Portal
− Electronic via clearinghouse
− Via paper predetermination

> Must be submitted on a current ADA Claim Form
> Cannot be handwritten

− Authorizations can be mailed to: 
Centene Dental       
Authorizations KS
P.O. Box 25857
Tampa, FL, 33622-5857

• Authorizations will be determined within 7 
calendar days.

• Authorizations are good for 180 calendar days 
from the date of approval.

Authorizations
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Claims Submissions:

• Provider Web Portal

• Paper Claim: 
− Must be submitted on current ADA 

claim form
− Cannot be handwritten 
− Mail to: 

− Centene Dental - Claims KS
    P.O. Box 25857
     Tampa, FL 33622-5857

• Electronically through a Clearinghouse
− Payor ID is: 46278

Turnaround Times:

• Timely Filing: 
− Medicaid - Claims must be 

submitted within 180 days from 
Date of Service. 

− Ambetter - Claims must be 
submitted within 180 days from 
Date of Service. 

• When filing to Centene Dental Services 
as secondary payor, timely filing is 180 
calendar days from date on primary 
EOB. 

Claims
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• If the member has a commercial insurance 
plan, Medicaid is always the secondary 
payor.  

• Providers must first submit the claim to the 
primary insurance and include a full 
explanation of benefits when submitting to 
Medicaid for secondary payment 
consideration.  

• Claims can be submitted via a 
clearinghouse, our Provider Web Portal, or 
via a current ADA paper claim

Coordination of Benefits
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Appeals – Grievances (Medicaid)

Frequently Asked Claims Questions

• Authorization Appeals:

− Timely Filing:  63 Calendar Days after the notice of action date.

− Determination: 30 Calendar Days

− Mail to:  Sunflower Health Plan Appeals, P.O. Box 10287, Van Nuys, CA 91410-0287

• Claim Appeals:

− Timely Filing:  63 Calendar Days after the notice of action date.

− Determination: 30 Calendar Days

− Mail to:  Centene Dental Appeals and Grievances, P.O. Box 25857, Tampa, FL 33622-5857

− Secure Email (DentalAppeals@Centene.com) 

• Claim Reconsideration (optional at provider’s request):

− Must be requested within 120 calendar days of the Notice of  Action date. Three additional 

− calendar days will be allowed for mailing time. 

*Reconsiderations and appeals will be resolved within 30 calendar days from the date of receipt.

mailto:DentalAppeals@Centene.com
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Contact us:

• Provider Relations:  email: DentalProviderRelations@Centene.com
• Provider Customer Service:  855-434-9245
• Credentialing Department: DentalCredentialing@Centene.com
• Network Department: DentalNetwork@Centene.com
• Envolve Dental Fraud Waste and Abuse Hotline: 866-685-8664

− Email: EBOSIU@Centene.com

• Appeals and Grievances: 
• Appeals Email: DentalAppeals@Centene.com
• Grievances Email: DentalGrievances@Centene.com

mailto:DentalProviderRelations@Centene.com
mailto:DentalCredentialing@Centene.com
mailto:DentalNetwork@Centene.com
mailto:EBOSIU@Centene.com
mailto:DentalAppeals@Centene.com
mailto:DentalGrievances@EnvolveHealth.com
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Questions?
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Dental Hub

The Dental Hub is the go-to website for your practice’s administrative tasks. 

Use a single sign-on to see and manage your business — even if you have multiple 

practices and locations 

Submit claims through a streamlined process with instant edits that help you avoid 

errors 

Convert determined prior authorization requests into claims with ease 

Process claims in real time and collect out-of-pocket amounts from patients while 

they’re still in the office. Real-time adjudicated claims and patient responsibility reports 

eliminate having to rely on estimates. 

Be informed of important processes and events through automated notifications

https://uhcpwp.wonderboxsystem.com/PWP/Landing
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Weekly Live Dental Hub Webinar

Join an upcoming live webinar held every Thursday at 12:00 

PM Central or watch the video on-demand 

The webinar will cover:

• Intro to the Dental Hub

• Self-registration

• Set-up

• Add a patient

• Check eligibility

• Treatment estimate

• Submit claims

• Reports

• Real-time patient responsibility

dentalhub.com/webinars

Email: dentalhubsupport@skygenusa.com

Dental HUB Support: 855-619-5156

https://www.dentalhub.com/webinars
https://www.dentalhub.com/webinars
mailto:dentalhubsupport@skygenusa.com
https://www.dentalhub.com/sites/default/files/2023-04/DH_Quick_Guide.v1.4_032023.pdf
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Sample Member ID Card
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Members are issued an identification (ID) card 

by UnitedHealthcare Community Plan. 

There will not be separate dental cards for 

UnitedHealthcare Community Plan members. 

The ID cards are customized with the 

UnitedHealthcare Community Plan logo and 

include the toll-free customer service number for 

the health plan. 

Please remember:

• A member ID card is not a guarantee of 

payment. It is the responsibility of the provider 

to verify eligibility at the time of service. 

To verify a member’s dental coverage, go to 

uhcdental.com/medicaid and sign into the Dental 

HUB or contact the dental Provider Services line 

at 855-878-5372, Monday – Friday 7:45 a.m. – 

4:30 p.m. CST (IVR: 24/7). 
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Patient eligibility verification
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1-855-878-5372UHCdental.com/medicaid

Patient eligibility and dental benefits may be verified online or via phone.  

• Once you have registered with the Dental HUB, you can verify your patients’ eligibility 

online with just a few clicks, 24 hours a day, 7 days a week.

• If verifying a patient’s dental coverage via phone, contact the dental Provider Services 

line at 855-878-5372, Monday – Friday 7:45 a.m. – 4:30 p.m. CST.

• We also offer an Interactive Voice Response (IVR) System for eligibility verification 24 

hours a day, 7 days a week.

Here are some key points to keep in mind: 

• Eligibility should be verified on the date of service. 

• Verification of eligibility is not a guarantee of payment. Payment can only be made after 

the claim has been received and reviewed in light of eligibility, dental necessity and 

other limitations and/or exclusions.



Authorizations & Claims
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Authorization Timelines & Submissions
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The Dental HUB

UHCdental.com/medicaid

Payer ID GP133

Electronic

Clearinghouse

Payer ID GP133

Paper

UnitedHealthcare Authorizations

PO Box 2135

Milwaukee, WI  53201

To make sure that desirable quality of care standards are achieved and to maintain the overall clinical 

effectiveness of the program, there are times when prior authorization is required prior to the delivery of 

clinical services. Refer to the provider manual and QRG for a complete listing of procedures requiring 

authorization.

We will make a determination on standard authorizations within 2 days of receipt of the request. Written 
notification of denied determinations will be sent within 14 calendar days of receipt of the request.

We will make a determination on expedited authorizations within 24 hours of receipt of the request. Written 
notification denied determinations will be sent within 2 business days of receipt of the request.

Authorization approvals will expire 180 days from the date of determination.

For questions concerning prior authorization, dental claim procedures, or to request clinical 
criteria, please call the Provider Services Line at 855-878-5372
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Claims Submission & Timely filing
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Submission

Timely 
submission 
(Timely filing)

All claims should be 

submitted within 180 

calendar days from the 

date of service.

Secondary claims must 

be received within 180 

calendar days of the 

primary payer’s 

determination.

All adjustments or 

requests for 

reprocessing must be 

made within 365 days 

from date of service, or 

date of eligibility 

posting, only if the initial 

submission time period 

has been met.  An 

adjustment can be 

requested in writing or 

telephonically. 

The Dental Hub

UHCdental.com/medicaid

Payer ID GP133

Paper

UnitedHealthcare KS Claims

PO Box 1158

Milwaukee, WI  53201

Electronic

Clearinghouse

Payer ID GP133
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Corrected Claim
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A corrected claim should ONLY be submitted when an original claim or service was PAID based upon incorrect information. As part 
of the process, the original claim will be recouped, and a new claim processed in its place with any necessary changes. 

Examples of correction(s) for a prior paid claim are:

• Incorrect Provider NPI or location

• Payee Tax ID

• Incorrect Member

• Procedure codes

• Services originally billed and paid at incorrect fees (including no 

fees)

• Services originally billed and paid without primary insurance

A corrected claim may be submitted using the methods below:

• Electronically through Clearing House

• Electronically through the Dental Hub.

• Paper to the mailing address below:

UnitedHealthcare Community Plan Corrected Claims

P.O. Box 481

Milwaukee, WI 53201

Electronic submission is the most efficient and preferred method. If providers do not have access to electronic submissions, and 

need to submit on paper, the following steps are required.

• Must be submitted to the Corrected Claims P.O. Box for proper processing and include the following:

– The most current version of the ADA claim form and all required information

– The ADA form must be clearly noted “Corrected Claim”

– In the remarks field (Box 35) on the ADA claim form indicate the original paid encounter number and   record all corrections 

you are requesting to be made.

Note: If all information does not fit in Box 35, please attach an outline of corrections to the claim form.

If a claim or service originally DENIED due to incorrect or missing information/authorization, or was not previously processed for

payment, DO NOT submit a corrected claim. Denied services have no impact on member tooth history or service accumulators,

and, as such, do not require reprocessing. Submit a new claim with the updated information per your normal claim submission

channels. Timely filing limitations apply when a denied claim is being resubmitted with additional information for processing.

If you received a claim or service denial which you do not agree with, including denials for no authorization, please refer to the

appeals language on the Provider Remittance Advice for guidance with the appeals process applicable to the state plan. 
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When non-covered services are provided for Medicaid members, providers shall hold members and 

UnitedHealthcare Community Plan harmless, except as outlined below. In instances when Medicaid non-

covered services are recommended by the provider or requested by the member, an Informed Consent 

Form or similar waiver must be signed by the member confirming:

• That the member was informed and given written acknowledgement regarding proposed treatment plan 

and associated costs of non-covered services in advance of rendering treatment; that those specific 

services are not covered under the member’s plan and that the member is financially liable for such 

services rendered.

• That the member was advised that they have the right to request a determination from the insurance 

company prior to services being rendered.

• Please note: It is recommended that benefits and eligibility be confirmed by the provider before 

treatment is rendered. Members are held harmless and cannot be billed for services that are covered 

under the plan.

Payment for non-covered services
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Tips for successful claim experiences

46

Do not let claim issues 

grow or go unresolved. 

Call Provider Services if 

you can’t verify a claim is 

on file.

Do not resubmit validated 

claims on file unless 

submitting a corrected 

claim with the 

required indicators.

File adjustment requests 

and claim disputes within 

contractual time 

requirements.

If you must exceed the 

maximum daily frequency for 

a procedure, submit the 

medical records justifying 

medical necessity. This 

should also include if a 

service is not identified as 

covered but is medically 

necessary for treatment. 

UnitedHealthcare Community 

Plan is the payer of last 

resort. This means you must 

bill and get an EOB from 

other insurance or source of 

health care coverage before 

billing UnitedHealthcare 

Community Plan. 

Secondary claims must be 

received within 365 calendar 

days from the date of 

service, even if the primary 

carrier has not made 

payment. The timely filing is 

for all claims.

When submitting appeal or 

reconsiderations requests, 

provide the same 

information required for a 

clean claim. 

Explain the discrepancy, 

what should have been paid 

and why.

If you have questions, call Provider Services.

855-878-5372



Provider resources

47
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Provider Essentials Cheat Sheet
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Need: Address: Phone Number:
Payer 

I.D.
Submission Guidelines: Form(s) Required

Claim Submission 

(initial)

Claims:

UnitedHealthcare KS Claims

P.O. Box 1158

Milwaukee, WI 53201

1-855-878-5372 GP133 Within 180 calendar days from 

the date of service.

For secondary claims, within 

180 calendar days from the 

primary payer determination

ADA* Claim Form, 2024 

version

Corrected Claims Corrected Claims:

UnitedHealthcare KS Claims

P.O. Box 481

Milwaukee, WI 53201

1-855-878-5372 N/A Within 365 days plus 3 

calendar days of the date the 

denial letter was mailed or the 

date of the Provider 

Remittance.

ADA Claim form Reason 

for requesting adjustment 

or resubmission

Claims Appeals 

(Appeal of a denied 

or reduced 

payment)

Claim Appeals:

UnitedHealthcare Appeals

P.O. Box 1244

Milwaukee, WI 53201

1-855-878-5372 N/A Within 60 days after the claim 

determination

Supporting 

documentation, including 

claim number is required 

for processing.

Prior Authorization 

Requests

Pre-authorizations:

UnitedHealthcare Authorizations

P.O. Box 2135

Milwaukee, WI 53201

1-855-878-5372 GP133 N/A ADA Claim Form – check 

the box titled: Request for 

Predetermination/Preauth

orization section of the 

ADA Dental Claim Form

Member Benefit 

Appeal for Services 

Authorization 

(Appeal of a denied 

or reduced service)

UnitedHealthcare Community

Attn: Appeals and Grievances Unit

P.O. Box 31364

Salt Lake City, UT 84131-0364

1-866-293-1796 N/A Within 60 calendar days from 

the date of adverse benefit 

determination

N/A
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Provider Road Map
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You want to:
Provider Services Line - 
Dedicated Service Representatives

Online
uhcdentalproviders.com

Interactive Voice Response (IVR)
System and Voicemail
Hours: 24 hours a day, 7 days a week

Ask a Benefit/Plan Question
(including prior authorization requirements) P P

Ask a question about your contract P

Changes to practice information (eassociate 
updates, address changes, adding or deleting 
addresses, Tax Identification Number change, 
specialty designation) P P

Inquire about a claim P P P

Inquire about eligibility P P P

Inquire about the In-Network Practitioner Listing P P P

Nominate a provider for participation P P

Request a copy of your contract P

Request a Fee Schedule P P

Request an EOB P P

Request an office visit (e.g., staff training) P

Request benefit information P P

Request documents P P

Request participation status change P

We are committed to providing your office accurate and timely information about our programs, products and policies. 

Our Provider Services Line 855-878-5372 and Provider Services teams are available to assist you with any questions you 

may have. 

Our toll-free provider services number is available during normal business hours and is staffed with knowledgeable 

specialists. They are trained to handle specific dentist issues such as eligibility, claims, benefits information and 

contractual questions.

UHCdental.com/medicaid



Resources



Resources for Dental Providers

https://pathwaystooralhealth.org/wp-
content/uploads/2025/06/Filing-Claims-v5.pdf 

https://pathwaystooralhealth.org/blog/

https://pathwaystooralhealth.org/wp-content/uploads/2025/06/Filing-Claims-v5.pdf
https://pathwaystooralhealth.org/wp-content/uploads/2025/06/Filing-Claims-v5.pdf
https://pathwaystooralhealth.org/wp-content/uploads/2025/06/Filing-Claims-v5.pdf
https://pathwaystooralhealth.org/wp-content/uploads/2025/06/Filing-Claims-v5.pdf
https://pathwaystooralhealth.org/wp-content/uploads/2025/06/Filing-Claims-v5.pdf
https://pathwaystooralhealth.org/wp-content/uploads/2025/06/Filing-Claims-v5.pdf
https://pathwaystooralhealth.org/wp-content/uploads/2025/06/Filing-Claims-v5.pdf
https://pathwaystooralhealth.org/blog/


Resources for Dental Providers

https://oralhealthkansas.org/MedicaidAdultDentalBenefits.html 

https://oralhealthkansas.org/MedicaidAdultDentalBenefits.html


I’m here to help!

Bryan Thompson, Dental Medicaid Facilitator
bthompson@oralhealthkansas.org

785-493-2649

mailto:bthompson@oralhealthkansas.org




Dental Provider Advisory Group





August 19: Medicaid Dental: New Rates, Better Coverage

August 26: Your Practice, Your Way: Managing Your Patient Mix

September 2: Get to Know Your MCOs

September 9: Enrollment & Credentialing

September 16: Filing Medicaid Claims

September 23: Do Well by Doing Good: Medicaid Opportunities

September 30: My Dental Care Passport

New Era, New Opportunities Webinar Series


	Slide 1
	Slide 2
	Slide 3
	Slide 4
	Slide 5
	Slide 6
	Slide 7
	Slide 8
	Slide 9: Healthy Blue Kansas Oral Health Kansas Webinar 09/16/2025
	Slide 10: member identification card
	Slide 11: SKYGEN - Dental Hub
	Slide 12: checking Eligibility
	Slide 13: checking Eligibility
	Slide 14: checking Eligibility
	Slide 15: Key Addresses 
	Slide 16: Plus - Submitting a Corrected Claim
	Slide 17: submitting a corrected claim - clearinghouse
	Slide 18: submitting a corrected claim - mail
	Slide 19: Timely filing
	Slide 20: Payments options
	Slide 21: key contacts   
	Slide 22
	Slide 23: Sunflower Health Plan
	Slide 24: John Dane, DDS Sunflower Health Plan
	Slide 25
	Slide 26: State Plan Information and ID Cards
	Slide 27: Provider Web Portal
	Slide 28: Provider Web Portal
	Slide 29: Authorizations
	Slide 30: Claims
	Slide 31: Coordination of Benefits
	Slide 32: Frequently Asked Claims Questions
	Slide 33
	Slide 34
	Slide 35: Dental HUB
	Slide 36
	Slide 37
	Slide 38: Member information
	Slide 39: Sample Member ID Card
	Slide 40: Patient eligibility verification
	Slide 41: Authorizations & Claims
	Slide 42: Authorization Timelines & Submissions
	Slide 43: Claims Submission & Timely filing
	Slide 44: Corrected Claim
	Slide 45: Payment for non-covered services
	Slide 46: Tips for successful claim experiences
	Slide 47: Provider resources
	Slide 48: Provider Essentials Cheat Sheet
	Slide 49: Provider Road Map
	Slide 50
	Slide 51
	Slide 52: Resources for Dental Providers
	Slide 53
	Slide 54
	Slide 55: Dental Provider Advisory Group
	Slide 56
	Slide 57

